METHODOLOGY WIZARDS
PLUGIN

18.1
(technology preview)

No Magic, Inc.
2015
CONTENTS

1 INTRODUCING METHODOLOGY WIZARDS 4
   Methodology Wizards concepts 4

2 INSTALLING AND RUNNING METHODOLOGY WIZARD PLUGIN 6

3 METHODOLOGY WIZARD TEMPLATE DESCRIPTION 7
   Use Case template 7
   Analysis Classes Creation Wizard 7

4 CUSTOMIZING METHODOLOGY WIZARD 8
   Case Study - creating a new wizard 8
   Steps description 11
      General steps description 11
      Wizard_Name step description 11
      Wizard_Capture step description 13
      Wizard_Relate step description 15
      Wizard_Text step description 17
   Hyperlinks extension description 18
1 INTRODUCING METHODOLOGY WIZARDS

Methodology Wizards Plugin (technology preview*) - Automates modeling tasks and extends methodology support in MagicDraw. This Wizard guides you through model creation process according to a set methodology.

To try the Methodology Wizards plugin, go to the Help menu and select the Resource/Plugin Manager to see the list of available plugins. Select the Methodology Wizards Plugin to download and install.

Samples of the tasks those can be automated:

- Creating models (Use Case, Domain Analysis Classes, and others);
- Creating a glossary;
- Creating multiple elements with a single click;
- Invoking related features directly from the wizard (report generation, metrics, validation, matrix and others).

To describe wizard possibilities in more details:

- Wizard allows to visualize process described with SPEM or UML Activity.
- Wizard allows new model data creation, for example: Actors, Use Cases, Packages, System boundary, relations between them.
- Already existing model data are also visible and modifiable in wizard.
- Wizard allows to describe elements details.

Methodology Wizards engine consists of customizable model based steps and can be adapted to fit your work processes. See "Customizing Methodology Wizard" on page 8.

For information on how to install and run the Methodology Wizard plugin, see "Installing and Running Methodology Wizard Plugin" on page 6.

Methodology Wizards concepts

Wizard functionality (templates) reuses Software Process Engineering Metamodel (SPEM 2.0) or UML Activities as template source. SPEM is used describing many process, RUP and Agile ones. But in order to help people use this process, to automate tasks, to suggest best way wizards helps.
Wizard template is described with Activity and Actions from UML Activity diagram (or SPEM Task with Inner Steps from Workflow diagram). Wizard takes created template as source and represents step by step to user in ordinary wizard GUI.

Model wizard is convenient and customizable. It allows to capture new and existing (already created in model) data. For more information about wizard customization, see "Customizing Methodology Wizard" on page 8.

To download the SPEM plugin, go to the Help menu and select the Resource/Plugin Manager to see the list of available plugins (select to display All Resources in the Filter drop down list).
2 INSTALLING AND RUNNING METHODOLOGY WIZARD PLUGIN

In this section you will find information on how to install the Methodology Wizard plugin and how to start working with Methodology Wizard plugin.

Installing the Methodology Wizard plugin

To install the Methodology Wizards plugin, go to the Help main menu and select the Resource/Plugin Manager. Select the Methodology Wizards Plugin to download and install. After automatic download and installation restart MagicDraw to activate plugin.


Starting to work with the Methodology Wizard plugin

To create the new project for the process guide, create new project from the Process Guide Project template:

1. From the File menu, choose New Project. The New Project dialog box appears.
2. Select the Process Guide Project item in the list. New project is created.

Project includes profiles for wizards, SPEM profile and diagram with detailed description of stereotypes and tags, which can be used for your own wizard creation.

Loading a sample with already created wizards

To load the sample with two already created wizards - Use Case Model Creation Wizard and Analysis Classes Creation Wizard - open the Use_Case_Model_Creation_Wizard_Template.mdzip project, which you can find in the <MagicDraw installation folder>/samples/process guide directory.

After loading the sample, you can invoke these two wizards from the Tools main menu, the Wizards command.
3 METHODOLOGY WIZARD
TEMPLATE DESCRIPTION

Templates are described with SPEM or UML. SPEM Task (Activity) and Steps (Action) elements additionally described are interpreted and represented by wizard feature.

Use Case template

Use Case modeling is one of the basic and initial system description step. Wizard offers straight forward artifact input, relations creation, and views creation and related features as documentation generation, model validation.

Use Case model creation wizard allows easy capture data and create model without diagramming need.

Use Case model creation wizard primary user roles are users those do not wish or has no knowledge’s of modeling. Those users expect that diagram creation from model would be automated.

Advantages of the Use Case template usage:
- Wizard allow straight forward Use Case model creation without need for process knowledge.
- Wizard allow to create use case model without modeling (diagramming).
- Wizard give clear understanding possible Use Case model deliverable and next steps by offering features and views.
- Wizard is flexible and suitable for custom needs and processes, because it is customizable.

Analysis Classes Creation Wizard

Analysis Classes Creation Wizard is a robustness classes template.

Wizard description: “Wizard helps defining your system analysis classes and perform Robustness system analysis.”
4 CUSTOMIZING METHODOLOGY

WIZARD

Because of different process wizard allows customization tailoring for needs. It is possible to change steps order, customize steps, create new wizard, choose validation constraints and report templates from whom reports should be generated, etc.

Wizard has 4 different types of customizable steps:

- **Name** - allows to name system or to choose existing one which will be filled or edited.
- **Create and Describe** – shows list (or tree) of elements with adding removing possibility and with custom properties those can be described for those elements. Package change is available in this step also. Multiple elements can be created at time from multiline text input in this step.
- **Relate** – represents matrix like table which allows to relate any type of elements in handy way.
- **Text** – represents test for information and navigation purpose.

Wizard templates customization is done through model.

- Stereotypes «wizard» and «wizard_<step type>». Note: Load wizard.xml profile for stereotypes.
- Each stereotype has tags representing wizard and wizard steps properties.

Wizard template is created by applying «wizard» stereotype on Activity and «wizard_<step type>» stereotypes on Actions. Actions order connected from first till last and starting from initial node and finishing with final node corresponds to wizard steps order.

The table showing how the Wizard is customized or created using the model based template.

<table>
<thead>
<tr>
<th><strong>Wizard</strong></th>
<th><strong>Model Based Template</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Wizard</td>
<td>Activity with stereotype «wizard». Containing stereotyped actions connected to flow. Actions are stereotyped according to step type: «wizard_Name», «wizard_Capture», «wizard_Relate», «wizard_Text».</td>
</tr>
<tr>
<td>Wizard step</td>
<td>Stereotyped actions with one of stereotypes.</td>
</tr>
<tr>
<td>Wizard steps order</td>
<td>Flow of the actions representing wizard steps order with initial and Final Nodes.</td>
</tr>
<tr>
<td>Step details</td>
<td>Stereotyped action tags values.</td>
</tr>
</tbody>
</table>

**Case Study - creating a new wizard**

This case study presents step-by-step instructions for creating a new wizard from the beginning.

We want to create wizard, which would help user to describe system using Use Case model with little knowledge of modeling. Use Case modeling is one of the basic and initial system description steps. We will introduce how to create step by step guide helping start they system by Use Case modeling. How to create structure, capture actors and use cases, and create views as diagrams and matrices. Created wizard offers straight forward artifact input, relations creation, views creation, and related features as documentation generation, validation.

Created wizard will guide user through use case and model creation.
Advantages of wizard:

- Straight forward Use Case model creation without need for process knowledge.
- No need for diagramming, increasing speed of model creation.
- Understanding in possible Use Case model deliverables and next steps by offering features and views.
- Flexibility by adopting process for user needs.

In this case study analyst will create Use Case model creation wizard for the end user. Sample of the created Use Case model wizard you can find in the <MagicDraw installation folder>\samples\process guide\Use_Case_Model_Creation_Wizard_Template.mdzip.

Steps which analyst performs for creating the Use Case model creation wizard:

1. Creates a new project from template.
   - From the File menu, choose New Project. In the New Project dialog box, select the Process Guide Project item.

2. To describe the wizard steps, and they order, creates the Activity diagram - Use Case Model Creation Wizard.
   - To associate Activity diagram to the wizard, analyst assigns the «wizard» stereotype to the Activity of the Activity diagram.

3. To define the system name and location of the created system, analyst creates the action in the Activity diagram.
   - Creates Action named Enter System Name.
   - Assigns the «wizard_Name» stereotype to the action.
   - To define the properties of this wizard step, analyst defines tags of the action. For more information about properties of the «wizard_Name» stereotype, see “Wizard_Name step description” on page 11.

4. Next step for Use Case model creation would be to guide the end user through the elements creation in the system. For this analyst creates the wizard step for the Actors creation:
   - Creates the Capture Actors Action.
   - Assigns the «wizard_Capture» stereotype to the action.
   - Defines the stereotype properties - tags of the action. For more information about properties of the «wizard_Capture» stereotype, see “Wizard_Capture step description” on page 13.

5. Analyst creates the wizard step for the use cases creation. The Capture Use Cases action is created and the «wizard_Capture» stereotype is assigned to it.

6. After Actors and Use Cases are created they can be related. Analyst creates wizard step for the Actors and Use Cases relation:
   - Creates the Relate Use Cases and Actors action.
   - Assigns the «wizard_Relate» stereotype to the action.
   - Defines the stereotype properties - tags of the action. For more information about properties of the «wizard_Relate», see “Wizard_Relate step description” on page 15.

7. For structuring Use Cases, analyst creates a new wizard step for adding include, extend, and generalization relations between Use Cases. The Structure Use Cases action is created and the «wizard_capture» stereotype is assigned to it.

8. Next step for Use Case model creation wizard would be to guide user through use case grouping and description. For this analyst:
   - Creates the Detail Use cases and describe flow of events action.
   - Assigns the «wizard_Capture» stereotype to action and defines properties of stereotypes.
9. Now model creation is prepared and it left only one step for analyst - to create wizard step. Analyst creates the wizard step for suggesting further actions creating views and choosing suggested further steps and futures:
   - Creates the Create views and move to further steps action.
   - Assigns the «wizard_Text» stereotype to action.
   - Defines the stereotype properties. For more information about properties of the «wizard_Text», see "Wizard_Text step description" on page 17.

10. After wizard steps are created order of wizard steps should be defined. For this analyst does the following actions in the Activity diagram:
   - Creates the Control Flow relationship between actions.
   - Creates the initial and final node in the Activity diagram.

Wizard template is created and can be shared for usage. Wizard can be started from Tools main menu, Wizards.

Figure 1 -- Use Case Model Creation Wizard
Steps description

This section describe the second step of the wizard creation - creating and description of wizard steps. There are four steps: name, create and describe, relate and text. Step is described by assigning to action one of the stereotypes. See the table bellow there step, stereotype and link to the description are presented.

<table>
<thead>
<tr>
<th>Step</th>
<th>Stereotype</th>
<th>Link to the description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>wizard_Name</td>
<td>&quot;Wizard_Name step description&quot; on page 11</td>
</tr>
<tr>
<td>Create and Describe</td>
<td>wizard_Capture</td>
<td>&quot;Wizard_Capture step description&quot; on page 13</td>
</tr>
<tr>
<td>Relate</td>
<td>wizard_Relate</td>
<td>&quot;Wizard_Relate step description&quot; on page 15</td>
</tr>
<tr>
<td>Text</td>
<td>wizard_Text</td>
<td>&quot;Wizard_Text step description&quot; on page 17</td>
</tr>
</tbody>
</table>

General steps description

Each of these stereotypes has its tags. Tags describe properties of the step and its GUI.

Step name

Each stereotyped action name is used as step name.

Navigation buttons in each wizard

Each wizard step have such default buttons:

- **<Back** - one step back. Disabled if this is first step.
- **Next** - one step forward. Disabled if this is last step.
- **Finish** - Close wizard. Enabled only if it is last step.
- **Cancel** - Close wizard.
- **Help** - Start standard MagicDraw help, providing description of wizards engine and about build in wizards templates.

Navigating from wizard to the action

Click on **Edit** link in wizard left bottom corner will navigate to step element in browser, also will open first diagram and select it in diagram if diagram with this step is available.

wizard_Name step description

In the wizard_Name step you can choose to create new system or select existing system, in which your model will be created.

Here system is called the element, which is defined in action, tag property: *type*.

This step should be added before wizard_Capture, and wizard_Relate steps.

If this step is not added to the wizard, by default the Data - model root is used as default owner.

If the **Create new** radio button is selected, text box to add new element name and tree to select it owner is shown (see Figure 2 on page 12).
If the **Select existing** button is selected, drop down list is shown with existing elements. In this case, Wizards Model is created in the selected element.

![Figure 2 -- The sample of the wizard_Name step](image)

See the «wizard_Name» stereotype properties descriptions in the following table.

<table>
<thead>
<tr>
<th>Stereotype property</th>
<th>Required/Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>Required</td>
<td>Type of the element you can create as system representation.</td>
</tr>
<tr>
<td>stepDescription</td>
<td>Optional</td>
<td>Step description.</td>
</tr>
<tr>
<td>selectNameDescription</td>
<td>Optional</td>
<td>System Name field description.</td>
</tr>
<tr>
<td>selectOwnerDescription</td>
<td>Optional</td>
<td>Select owner field description.</td>
</tr>
<tr>
<td>selectExistingDescription</td>
<td>Optional</td>
<td>Existing system selection field description.</td>
</tr>
</tbody>
</table>
wizard_Capture step description

The wizard_Capture step allows to capture elements of specific type, place into specific owner and customize properties of them.

See the Wizard Capture GUI description in the following table.

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Tree/List]</td>
<td>Toggles elements display style Tree / List. In Tree style elements (of selected type) are listed with owners of them. Elements of other types are listed only if they are defined in owners tag. Tree starts with owner selected on first step. In List style elements are listed in plain list: <code>&lt;icon&gt;&lt;name&gt;[&lt;qualified name starting from owner selected on first step&gt;]</code>.</td>
</tr>
<tr>
<td>![Organize]</td>
<td>Organize element location, move element up down through owners structure. Buttons are enabled in Tree style only. They move selected element Up / down through owners structure.</td>
</tr>
<tr>
<td>![Less/More]</td>
<td>Shows / hides element properties. Whole area in right side of dialog together with documentation field is toggled. On the Select/Create Owner button click, existing owner selection dialog appears with ability to create new owner according to showOwners tag values.</td>
</tr>
<tr>
<td>![Owners]</td>
<td>Text displays owners where element will be created after Create button click.</td>
</tr>
</tbody>
</table>
CUSTOMIZING METHODOLOGY WIZARD

Steps description

**Image**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input text field for element name. From each line of text element will be created. Elements will be created in selected location on <strong>Create</strong> button click. Owner of element that should be created also can be input into this text field. For example, if you type <code>package::package1::Actor1</code> and click <strong>Create</strong> button, <code>package1</code> will be created in package and <code>Actor1</code> will be placed in package1.</td>
</tr>
</tbody>
</table>

Removes selected element from model.

See the «wizard_Capture» stereotype properties description in the following table.

<table>
<thead>
<tr>
<th>Stereotype properties</th>
<th>Required/Optional</th>
<th>Customized area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>Required</td>
<td>Element of this type will be shown in list, and will be created on <strong>Create</strong> button press. Type may be Metaclass or Stereotype. If stereotype as value is selected stereotyped element according stereotype Metaclass will be created. <strong>NOTE</strong>: Metaclasses or Stereotype should not be Abstract.</td>
<td>Type of element which you will be able to create and describe.</td>
</tr>
<tr>
<td>showOwners</td>
<td>Optional</td>
<td>Element of this type will be shown in Tree, but will not be created on <strong>Create</strong> button press. Owners will not be shown being in List mode.</td>
<td>Type of element which you will see in Tree as possible owners for elements. Also type of element those will be suggested to create from <strong>Create Owner</strong> button click. Type of owner, which will be created automatically on owner input in text field. First tag value will be taken as owner to create.</td>
</tr>
<tr>
<td>StyleTreeOrList</td>
<td>Required</td>
<td>Enumeration allowing defining in what style Tree or List elements will be displayed. <strong>List</strong> - List will be selected by default <strong>invisible_tree</strong> - button will be invisible and tree style will be selected. <strong>invisible_list</strong> - button will be invisible and list style will be selected.</td>
<td>Style in which elements will be shown: Tree or List.</td>
</tr>
</tbody>
</table>
### wizard_Relate step description

The wizard_Relate step shows matrix with elements in columns and rows.

- Click on empty cell creates selected relation from row to column.
- Click on cell with relation from row to column will show popup menu with options.
  - Reverse - if relation can be reversed, and it has direction. In other case this action should be disabled.
  - Edit - to invoke relation specification.
  - Remove - to remove relation.

<table>
<thead>
<tr>
<th>Stereotype properties</th>
<th>Required/ Optional</th>
<th>Customized area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>defaultOwner</td>
<td>Optional</td>
<td>Package which will be created or selected as default owner.</td>
<td>If provided this package will be created on entering into this step and this package will be selected. If package already exist in this scope it will be only selected. If package is not provided element will be added into owner selected on wizard_Name step.</td>
</tr>
<tr>
<td>stepDescription</td>
<td>Optional</td>
<td>Step description.</td>
<td></td>
</tr>
<tr>
<td>listDescription</td>
<td>Optional</td>
<td>Elements list description.</td>
<td></td>
</tr>
<tr>
<td>lessProperties</td>
<td>Required</td>
<td>&quot;&lt;Less&quot;, &quot;More&gt;&quot; button state</td>
<td>If True, element properties are not shown, and &quot;More&gt;&quot; button is visible.</td>
</tr>
<tr>
<td>limitScopeToOwner</td>
<td>Required</td>
<td>Scope of element visible in this wizard step.</td>
<td>If True element only from Owner selected in wizard_Name step will be shown. If False all elements from entire model will be shown.</td>
</tr>
</tbody>
</table>
Figure 4 -- Sample of the wizard_Relate step.

See the «wizard_Relate» stereotype properties description in the following table.

<table>
<thead>
<tr>
<th>Stereotype properties</th>
<th>Required/Optional</th>
<th>Customized area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rowType</td>
<td>Required</td>
<td>Row elements type. Type may be Metaclass or Stereotype. If stereotype as value is selected stereotyped element according stereotype Metaclass will be created. Specific elements will be show according to assigned metaclass or stereotype.</td>
<td>Type of elements those will be visible in table rows.</td>
</tr>
<tr>
<td>columnType</td>
<td>Required</td>
<td>Column element type. Type may be Metaclass or Stereotype. If stereotype as value is selected stereotyped element according stereotype Metaclass will be used. Specific elements will be show according to assigned metaclass or stereotype</td>
<td>Type of element those will be visible in table columns.</td>
</tr>
</tbody>
</table>
wizard_Text step description

The wizard_Text step shows html formatted text in all area. This step purpose is not only introduction but also guidance. Closely related with hyperlinks mechanism in MagicDraw it gives ability to navigate to samples, report templates, validation, wizards, and other needed resources.

<table>
<thead>
<tr>
<th>Stereotype properties</th>
<th>Required/Optional</th>
<th>Customized area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>relation</td>
<td>Required</td>
<td>Relations those will be allowed to create. Type may be Metaclass or Stereotype. If stereotype as value is selected stereotyped element according stereotype Metaclass will be created. Specific elements will be show according to assigned Metaclass or Stereotype if type is not abstract. If type is abstract - all inherited elements will be shown also.</td>
<td>Type of relations those will be allowed to create. All relations are listed as drop down combo box selection. If there is only one relation drop down combo box will be not editable. Click cell will show available popup menu actions to edit, reverse, delete relation. If multiple relations of the same type are available between two elements &quot;X&quot; are shown. Right-click on X will display popup list with all relations of this type.</td>
</tr>
<tr>
<td>stepDescription</td>
<td>Optional</td>
<td>Step description.</td>
<td></td>
</tr>
<tr>
<td>tableDescription</td>
<td>Optional</td>
<td>Table description.</td>
<td></td>
</tr>
<tr>
<td>limitScopeToRemove</td>
<td>Required</td>
<td>Scope of element visible in this wizard step.</td>
<td>If True element only from Owner selected in wizard_Name step will be shown. If False elements from entire model will be shown.</td>
</tr>
</tbody>
</table>
Hyperlinks extension description

Links to various MagicDraw functionality are available from any place of MagicDraw where html text can be added: text boxes, notes, elements, wizards, and so forth.

References can be added into report templates, wizards, validation suites, and other MagicDraw areas.

For more information, see "Hyperlinks extension description" on page 18.
All additional protocols are available with wizards functionality plugin.

![Edit Hyperlink dialog box](image)

*Figure 6 -- Edit Hyperlink dialog box (Methodology Wizard plugin is activated)*

<table>
<thead>
<tr>
<th>Tab name in Edit Hyperlink dialog</th>
<th>On-click action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Specified Webpage will open.</td>
</tr>
<tr>
<td>File</td>
<td>Specified file will open.</td>
</tr>
<tr>
<td>Element/Symbol</td>
<td>Element or symbol with specified URL will be selected in the Model Browser or on diagram pane correspondingly.</td>
</tr>
</tbody>
</table>
| Report                            | Report from a selected template will be generated for a specified scope.  

*If you need the owner defined in the wizard_Name step to be taken as the scope, do not change the default scope parameter value, which is "$wizard_Name.Selection".*  
*If scope parameter is not defined, the Data root package will be taken as scope.*

| Validation                        | Specified scope of the model will be validated against a selected validation suite with specified severity.  

*If you need the owner defined in the wizard_Name step to be taken as the scope, do not change the default scope parameter value, which is "$wizard_Name.Selection".*  
*If scope parameter is not defined, the Data root package will be taken as scope.*

| Model Wizard                      | Specified model wizard will be started for the selected scope, if the «wizard» stereotype is applied on the referenced element.  

*If you need the owner defined in the wizard_Name step to be taken as the scope, do not change the default scope parameter value, which is "$wizard_Name.Selection".*  
*If scope parameter is not defined, the Data root package will be taken as scope.*
<table>
<thead>
<tr>
<th>Tab name in Edit Hyperlink dialog</th>
<th>On-click action</th>
</tr>
</thead>
</table>
| Model Transformation             | Specified model transformation of a selected scope will be started.  
If you need the owner defined in the `wizard_Name` step to be taken as the scope, do not change the default scope parameter value, which is “$wizard_Name.Selection”.  
If scope parameter is not defined, the Data root package will be taken as scope. |
| Visualizer Wizard                | Specified visualizer wizard will be started for the selected scope.  
If you need the owner defined in the `wizard_Name` step to be taken as the scope, do not change the default scope parameter value, which is “$wizard_Name.Selection”.  
If scope parameter is not defined, the Data root package will be taken as scope. |